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About the author- Arup Kumar Datta 

• Arup Kumar Datta was born in 1946 at Jorhat in Assam.  

• He was educated at cAanacar and at Delhi University.  

• He served as a professor in English for many; ars at JB College, Jorhat.  

• His published works ‘The Adventure Stories’ (1978), Brahmaputra (2001) have been translated into many 
foreign languages. 

 

About the story 
 

• Tea is really a very popular beverage in India. 

• You can bear the vendor shouting “chai-garam-garam chai” at every railway station. 

• More than eighty crores of cups of tea are drunk every day throughout the world. 

• It was green, green everywhere and Rajvir had never seen so much greenery before. 

• The landscape changed and tea bushes took the place of green paddy fields. 

• A sea of tea-bushes stretched as far as the eyes could go. 

• Assam has the largest concentration of plantations in the world. 

• No one really knows who discovered tea. 

• One Chinese legend says that a few leaves of the twigs burning under the pot fell into the boiling water. 

• The leaves gave it a delicious flavour. They were tea leaves. 

• Words like Thai’ and thine are from the Chinese language. 

• According to an Indian legend, an ancient Buddhist ascetic cut off his eyelids because he felt sleepy during 
meditation. 

• Ten tea plants grew out of his eyelids. 

• Rajvir saw acre upon acre of tea bushes and nearly all of them were neatly pruned to the same height. 

• Groups of tea-pluckers with bamboo baskets on their backs were plucking newly sprouted leaves. 

• A tractor was pulling a trailer-load of leaves. 

• Rajvir asked Pranjol’s father if it was the second-flush or sprouting period. 

• The sprouting periods lasts from May to July and this period yields the best tea. 
. 

THEME  

 

The lesson gives a graphic description of the sea of tea bushes stretching as far as eyes can 
go in Assam. The plucking of the newly sprouted leaves by groups of tea-pluckers with bamboo 
baskets on their backs are vividly described in the lesson. 

 
Rajvir: Pranjol: 

• He was a youngster and classmate of Pranjol in 
Delhi. 

•  He was excited to visit Tea estate in Assam.  

• He was invited there by Pranjol to spend 
summer vacation.  

• He was an ardent fan of detective stories.  

• He enjoyed seeing the magnificent view of tea-
bushes in Assam.  

• He had been born and brought up on a tea 
plantation.  

• He studied with Rajvir in Delhi.  

• His father was the manager of a tea-garden in 
upper Assam.  

• He invited Rajvir to visit his home and the 
Dhekiabari Tea Estate during summer vacation.  

• He was an ardent fan of detective stories. 



• His knowledge about tea and its history was 
profound.  

• He had done a lot of reading about tea.  

• He even surprised Pranjol’s father with his in-
depth knowledge of the subject. 

 

 

Extract Based Question (Solved) 
1. It was a magnificent view. Against the backdrop of densely wooded hills, a sea of tea bushes stretched 

as far as the eye could see. Dwarfing the tiny tea plants were tall sturdy shade trees and amidst the 
orderly rows of bushes busily moved doll-like figures. In the distance was an ugly building with smoke 
billowing out of tall chimneys. “Hey, a tea garden!” Rajvir cried excitedly. 

(a) Why is the building called ugly? 

(b) Why does the author call the tea plants ‘a sea of tea bushes’? 

(c) What have the tea plantations been compared to? 

(d) What are the doll-like figures referred to here? 

Ans. (a) This is because smoke was billowing out of tall chimneys of the building. 
(b) The tea bushes were stretched as far as the eye could see just like a sea. 
(c) A sea. 
(d) Tea-pluckers. 

 

 
2. Pranjol’s father slowed down to allow a tractor, pulling a trailer-load of tea leaves, to pass. 
“This is the second-flush or sprouting period, isn’t it, Mr Barua ?” Rajvir asked. “It lasts from May to July, 
and yields the best tea.” 
“You seem to have done your homework before coining.” Pranjol’s father said in surprise. 
 “Yes, Mr Barua,” Rajvir admitted. “But I hope to learn much more while I’m here.” 
(a) Why did Mr Barua feel surprised? 
(b) How did Rajvir want to spend his stay there? 
(c) Where were Rajvir and Mr Barua going? 
(d) Why did Mr Baruna slow down his car? 
Ans. (a) He was surprised to know that Rajvir knows a lot about tea plants 
(b) He wanted to learn much more about tea plants. 
(c) They were going to Dhekiabari Tea Estate. 
(d) He wanted to allow a tractor, pulling a trailer-load of tea leaves to pass. 

 

Extract Based Questions (Unsolved) 
1.”Chai garam…. garam chai” a vendor called out in a high pitched voice. He came up to their window and 
asked, Thai, sa’ab” ? “Give us two cups,” Pranjol said. They sipped the steaming hot liquid. Almost 
everyone in their compartment was drinking too. “Do you know that over 8,00,000,000 cups of tea are drunk 
every day all over the world ?” Rajvir asked. 

(a) Who was speaking in a high pitched voice and for what? 

(b) What was ordered by Pranjol? 

(c) What information did Rajvir give? 

(d) Where were the two boys going? 

2. ”Tea was first drunk in China,” Rajvir added, “as far back as 2700 B.C.! In fact words such as tea, chai 
and chini are from Chinese. Tea came to Europe only in the sixteenth century and was drunk more as 
medicine than a beverage”. The train clattered their luggage and pushed their way to the crowded platform. 
Pranjol’s parents were waiting for them. 

(a) In which country was tea drunk first? 



(b) From which language were the words, ‘char and ‘chin? adopted in Hindi? 

(c) Where was tea drunk first? 

(d) Which words are from Chinese? 

Short Answer Type Question (Solved) 

 
1. Why did Rajvir visit Assam? 
 Ans.  

• Rajvir had been invited by his classmate Pranjol, who was from Assam,  

• He was invited to visit his home during the summer vacation. 
2. How does Rajvir describe the tea-garden at Dhekiabari? 
Ans.  

• On both sides of the gravel road were acres and acres of neatly pruned tea bushes.  

• It was the second sprouting period.  

• Women wearing plastic aprons were plucking new tea leaves and putting them in the bamboo baskets. 

 

Short Answer Type Questions (Unsolved) 
1. Draw a pen picture of tea gardens in Assam. 
2. Describe the scenery that Rajvir saw as soon as the train pulled out of the station. 
3. How are tea pluckers different from other farm labourers? 
4. How can you say that tea was first drunk in China? 

 

 

Long Answer Type Question (Solved) 
What are the legends related to the discovery of tea? 
Ans.  

• There are many popular legends about the discovery of tea. Two of them are as follows — 

• A Chinese emperor was used to drinking boiled water.  

• One day a twig from the fire fell into the pot in which water was being boiled.  

• It gave a delicious flavour to the drink.  

• It is said that those were tea leaves.  

• An Indian legend goes like this.  

• Once there was a Buddhist ascetic who used to feel sleepy during meditations.  

• So he cut off his eyelids.  

• Ten tea plants grew out of the eyelids.  

• When the leaves from these plants were put in hot water and drunk they banished sleep. 

 

Long Answer Type Question (Unsolved) 

1. What details do you gather about tea from the lesson, ‘Tea from Assam’? 

2. What landscape did Rajvir notice while sitting in the train? 

3. Where were Pranjol and Rajvir going? What did Rajvir see when he looked out of the train on the 
way? 

4. What did Rajvir tell Pranjol about the discovery of tea? 
 
VIDEO LINK: https://youtu.be/556J6f53k4g  

 
 
 

 
 
 
 
 
 

https://youtu.be/556J6f53k4g


GEOGRAPHY 

          Geography revision 

1. Examine the three major problems created as a result of indiscriminate utilization 

of natural resources. 

2. Mention any three features of arid soil. 

3. What is regur soil? Write its two features. Mention two regions where they are 

found. 

4. “Indiscriminate use of natural resources has led to numerous problems.” Justify 

the statement. 

5.  How can you contribute to minimize the pollution? Explain. 

6. “Land is a natural resource of utmost importance.” Justify the statement with 

appropriate arguments. 

7. Name the soil type which is widely found in western Rajasthan. Explain two 

important characteristics of this type of soil type which make it unsuitable for 

cultivation. 

8. Mention any three features of arid soil. 

Video link:- 

https://www.youtube.com/watch?v=jXVw6M6m2g0&feature=youtu.be  

https://www.youtube.com/watch?v=GScu4nRpZjI&feature=youtu.be  

Activity:-  Prepare a list of resources found in your state & also identify the resources that are 

important but deficit in your state.   

 

ECONOMICS 

Class: Xth  Subject: Social Science (Economics) 

Chapter 1: Development                          14th Aug. 2020 

Revision Notes:   
 

❖ Attributes of National Development 

➢ National Income 

It is the sum total of the incomes of all the residents of the country.  

• Countries with higher incomes are considered more developed than those with less 

income. 

➢ Per Capita Income 

It is the average income earned by each person of the country in a year. 

• It establishes a relationship between the income and population of a country. 

https://www.youtube.com/watch?v=jXVw6M6m2g0&feature=youtu.be
https://www.youtube.com/watch?v=GScu4nRpZjI&feature=youtu.be


• Countries with higher PCI are considered developed as it determines the amount of 

money at the disposal of each person of the country. 

• World Bank uses PCI for classifying countries as developed and developing in its World 

Development Report. 

• However, PCI hides the inequalities in income in the society. 

• As per the Central Statistics Office (CSO), India's PCI for the year 2013 was 

approximately Rs. 99,835 (calculated on Advance Estimates of National Income). 

• In India, the PCI of Goa is highest while that of Bihar is the lowest. 

 

 

➢ Infant Mortality Rate 

It is the number of children that die before attaining one year of age as a proportion of 

1000 live births in a year. 

• It indicates the development of health facilities in a country. 

• In India, Kerala has the lowest IMR while Bihar has the highest. 

➢ Literacy Rate 

It is the number of people above 7 years of age who are able to read and write with 

understanding. 

• More is the literacy rate, more developed a country will be. 

• India has a literacy rate of 71.2%. 

• Kerala has the highest literacy rate and Bihar has the lowest. 

 

Assignment 

1) W

hy do you think average income is an important criterion for development? 

Explain. (3) 

2) B

esides size of per capita income, what other property of income is important in 

comparing two or more societies? [2016-17, 2012] (3) 

Write a paragraph on your notion of what should India do, or achieve, to become a 

developed country.Video Links 

https://www.youtube.com/watch?v=h0KxUWVP5bA&t=543s 

https://www.youtube.com/watch?v=05Zp9AK1PhA 

https://www.youtube.com/watch?v=Pg9UVLotOKI 

https://www.youtube.com/watch?v=QB0vpxvvXDo 

 

 

 

https://www.youtube.com/watch?v=h0KxUWVP5bA&t=543s
https://www.youtube.com/watch?v=05Zp9AK1PhA
https://www.youtube.com/watch?v=Pg9UVLotOKI
https://www.youtube.com/watch?v=QB0vpxvvXDo


 

POLITICAL SCIENCE 
Pol sc assignment 

Revision federalism 

1 mark important questions  

 1. What is Panchayat Samiti? 

Ans. A few Gram Panchayats are grouped together to form a Panchayat Samiti or Block or a 

Mandal. 

2. Define Zila Parishad? 

Ans. All the panchayat Samitis or Mandals in a district together constitute the Zila Parishad. 

3. What is Mayor? 

Ans. Mayor is the head of a Municipal Corporation. 

4. The Subjects like-Defense, Banking and Communication are come under which list? 

Ans. .Union List 

5. Point out one feature in the practice of federation in India that is similar from that 

of Belgium. 

Ans. In both countries there are two or more levels of Government. 

6. Point out one feature in the practice of federation in India that is different from to 

that of Belgium. 

Ans. In Belgium Community Government is there, but in India such type of provision is not 

there. 

7. How many lists of subject have been provided in the Indian Constitution? 

Ans. Four comprehensive lists of subjects. Union List, State List, Concurrent List and 

Residuary List 

8.What is federalism? 

Ans. Federalism is a system of government, under which power is divided between a central 

authority and its various constituent units. 

9. Define Gram Panchayat. 

Ans. It is council consisting of several ward members at village level, often called the Panch and the head Sarpanch  

• VIDEO LINK: https://youtu.be/YfnCDP8XlSk  

https://youtu.be/YfnCDP8XlSk


 

HISTORY 
 

          Chapter-4 

         Assignment-4 

Write the answer of following questions questions not more than 100 words carry 5 marks.  

1. How did factories in England multiplay in the late 18 th century? 
2. How rapid was the process of Industrialisation in Britain? 
3. What problems did the cotton weaver face in India? 
4. Why did Industrialisation in India begin shifting from yarn to cloth production? 
5. Why were the British worried about imports from other countries? 
6. “Series of changes affected the patterns of Industrialisation in India by the early 20 th C “. Analyse the 

statement. 
7. What was the condition of women worker in factories? 
8. The system of advance proved harmful for the weaver. How? 
9. How did marketing affect trading practices in India? 
10. How did the British market their goods in India? 

 

VIDEO LINK: https://www.youtube.com/watch?v=axSX6JhsvJc&authuser=0  

 

 

 

PHYSICS 

LINK- https://youtu.be/b-LhGfkBGfA  

ASSIGNMENT 

1.  List the properties of magnetic lines of force. 

2.  Draw the magnetic field pattern due to :- (a) a bar magnet (b) a solenoid (c) straight current carrying conductor 

(d)  circular loop of wire 

3.  Why don’t two magnetic lines of force intersect each other? 

4.  State the rule which is used to find: - (a) Direction of magnetic field (b) Direction of force or motion (c) Direction 

of induced current  

5.  What is a solenoid? The magnetic field in a given region is uniform. Draw a diagram to represent it. 

 

 

 

https://www.youtube.com/watch?v=axSX6JhsvJc&authuser=0
https://youtu.be/b-LhGfkBGfA


 

 

CHEMISTRY 

East point school 

Assignment 2 

Class x  

Chemistry 

Question 1. How does electronic configuration of atoms change in a period with increase in atomic 

number? [2009] 

Ans. On moving across a period from left to right, the atomic number of the elements increases, therefore, the number of 

electrons in the valence shell increases from 1 to 8, i.e, the first element in the given period will have one electron in its 

valence shell and the last element in the same period will have eight electrons. 

 

Question.  Lithium, sodium and potassium form a Dobereiner’s triad. The atomic masses of lithium and potassium are 7 

and 39 respectively. Predict the atomic mass of sodium. [2009] 

Ans. Atomic mass of sodium = (At. mass of lithium + At. mass of potassium)/2 

                                            =(7+39)/2 =23 

State the first limitation of Mendeleev’s Periodic Table. [2009] 

Ans. Hydrogen was not given a fixed position in Mendeleev’s Periodic Table. 

 

Question 2.  Why was the system of classification of elements into triads not found suitable? [2009] 

Ans. (i) Only a few similar elements could be grouped into triads and quite a large number of elements were left out. 

(ii) It was also possible to group quite dissimilar elements into triads. 

 

Question.3 . Why could no fixed position be given to hydrogen in Mendeleev’s Periodic Table? [2009] 

 

 

Question 4. What are ‘groups’ and ‘periods’ in the periodic table? [2009] 

 

 

Question 5. Three elements A,B and C with similar properties have atomic masses X,Y and Z respectively.  The mass of 

Y is approximately equal to the average mass of X and Z. What is such an arrangement of elements called? Give one 

example of such a set of elements. [HOTS] 

 

 

Question 6.  Elements have been arranged in the following sequence on the basis of their increasing atomic masses. 

[HOTS] F, Na, Mg, Al, Si, P, S, Cl, Ar, K 

(a) Pick two sets of elements which have similar properties.  

(b) The given sequence represents which law of classification of elements? 

 

VIDEO LINK: https://www.youtube.com/watch?v=fPnwBITSmgU&authuser=0  

https://www.youtube.com/watch?v=fPnwBITSmgU&authuser=0


 

 

 

BIOLOGY 

Assignment 

Topic: How do organisms reproduce (5) 

Class X 

 

1.  ‘Still in the modern era some people blame women for the gender of the child especially if the new born is girl’. Do 

you agree with this statement? Why or why not. Explain in detail. 

 

2. Some flowers contain either stamens or carpel’s whereas some flowers contain both categorise the two types of 

flowers and give one example of each. 

Differentiate between the following : 

(a) Pollen tube and Style                                      (b) Fission in Amoeba and Plasmodium 

(c) Fragmentation and Regeneration                (d) Bud of Hydra and bud of Bryophyllum 

(e) Vegetative propagation and Spore formation 

 

3. Why do testes lie outside the abdominal cavity? 

 

4. List any four method of contraception used by humans? How does their use have direct effect on the health and 

prosperity of a family? 

 

5. The organisms formed by asexual reproduction are considered as clones. Why? 

 

6. Name the information sources making protein in the cell? What is the basic event in reproduction? 

 

7.What happens if the egg is not fertilised in human female? Explain. 

VIDEO LINK: https://www.youtube.com/watch?v=r3j9opDfNy0  

https://www.youtube.com/watch?v=NuyZL6vHE1E  

 

https://www.youtube.com/watch?v=r3j9opDfNy0
https://www.youtube.com/watch?v=NuyZL6vHE1E


 

MATHEMATICS 

 

 

VIDEO LINK: https://youtu.be/45fnPN8sKk8  

 

 

 

 

 

 

 

https://youtu.be/45fnPN8sKk8


 

SANSKRIT 

 

VIDEO LINK: https://www.youtube.com/watch?v=LKxzhnpCyaE&authuser=0  

 

 

 

 

 

https://www.youtube.com/watch?v=LKxzhnpCyaE&authuser=0


 

 

 

 

HINDI 

श्न 1 - इफ़्फ़न टोपी शुक्ला की कहानी का महत्वपूर्ण हहस्सा हकस तरह से है? 

उत्तर - इफ़्फ़न टोपी का पहला दोस्त था। दोनो ों एक दूसरे के हिना अधूरे थे। दोनो ों एक दूसरे 

से कोई िात नही ों छुपाते थे। टोपी का इफ़्फ़न की दादी से भी िहुत गहरा नाता था क्ोोंहक जो 

प्यार और अपनापन टोपी को उसके घर में नही ों हमला वह इफ़्फ़न और इफ़्फ़न की दादी से 

हमला। इसहलए कहा जा सकता है हक इफ़्फ़न टोपी शुक्ला की कहानी का महत्वपूर्ण हहस्सा 

है। 

 

  

 

प्रश्न 2 - इफ़्फ़न की दादी अपने पीहर क्ोों जाना चाहती थी ों? 

उत्तर - इफ़्फ़न की दादी हकसी इस्लामी आचार्ण की िेटी नही ों थी िल्कि एक जमी ोंदार की 

िेटी थी। दूध-घी खाती हुई िडी हुई थी परनु्त लखनऊ आ कर वह उस दही के हलए तरस 

गई थी। जि भी वह अपने मार्के जाती तो हजतना उसका मन होता, जी भर के खा लेती 

क्ोोंहक लखनऊ वाहपस आते ही उन्हें हिर मौलहवन िन जाना पडता। र्ही कारर् था हक 

इफ़्फ़न की दादी अपने पीहर जाना चाहती थी ों। 

 

  

 

प्रश्न 3 - दादी अपने िेटे की शादी में गाने-िजाने की इच्छा पूरी क्ोों नही ों कर पाई? 

उत्तर - दादी की शादी एक मौलवी पररवार में हुई थी और मौलहवर्ो ों के घर में शादी-ब्याह के 

अवसर पर कोई गाना-िजाना नही ों होता। इसी वजह से दादी अपने िेटे की शादी में गाने-

िजाने की इच्छा पूरी नही ों कर पाई। 

 

  

 



प्रश्न 4 - 'अम्मी' शब्द पर टोपी के घरवालो ों की क्ा प्रहतहिर्ा हुई? 

उत्तर - अम्मी! र्ह शब्द सुनते ही खाने की मेज़ पर िैठे सभी लोग चौ ोंक गए, उनके हाथ 

खाना खाते-खाते रुक गए। वे सभी लोग टोपी के चेहरे की ओर देखने लगे। 'अम्मी' शब्द उदूण 

का था और टोपी हहन्दू था, उसके मुुँह से र्ह शब्द सुन कर ऐसा लग रहा था जैसे रीहत-

ररवाजो ों की दीवार हहलने लगी हो। टोपी की दादी सुभद्रादेवी तो उसी वक्त खाने की मेज़ से 

उठ गई और टोपी की माुँ रामदुलारी ने टोपी को िहुत मारा। 

 

  

 

प्रश्न 5 - दस अकू्तिर सन पैंतालीस का हदन टोपी के जीवन में क्ा महत्त्व रखता है? 

उत्तर - दस अकू्तिर सन पैंतालीस का ऐसे तो कोई महत्त्व नही ों है परनु्त टोपी के जीवन के 

इहतहास में इस तारीख का िहुत अहधक महत्त्व है, क्ोोंहक इस तारीख को इफ़्फ़न के हपता 

िदली पर मुरादािाद चले गए। इफ़्फ़न की दादी के मरने के थोडे हदनो ों िाद ही इफ़्फ़न के 

हपता की िदली हुई थी। टोपी दादी के मरने के िाद तो अपनेआप को अकेला महसूस कर ही 

रहा था और अि इफ़्फ़न के चले जाने पर वह और भी अकेला हो गर्ा था। इसीहलए टोपी ने 

दस अकू्तिर सन पैंतालीस को कसम खाई हक अि वह हकसी भी ऐसे लडके से कभी भी 

दोस्ती नही ों करेगा हजसके हपता कोई ऐसी नौकरी करते हो हजसमें िदली होती रहती हो। 

 

  

 

प्रश्न 6 - टोपी ने इफ़्फ़न से दादी िदलने की िात क्ोों कही? 

उत्तर - इफ़्फ़न के घर में टोपी का सिसे अहधक मेलहमलाप उसकी दादी से था। दादी की 

िोली उसे िहुत पसोंद थी और टोपी की माुँ की िोली भी वही थी। टोपी को इफ़्फ़न की दादी 

का हर एक शब्द शक़्कर की तरह मीठा लगता था। पके आम के रस को सूखाकर िनाई गई 

मोटी परत की तरह मजे़दार लगता। हतल के िने व्योंजनो ों की तरह अच्छा लगता और वह 

दादी की डाुँट सुन कर चुपचाप उनके पास चला आता। टोपी को अपनी दादी हिलकुल भी 

अच्छी नही ों लगती थी। इसीहलए टोपी ने इफ़्फ़न से दादी िदलने की िात कही। 

 

  

 



प्रश्न 7 - पूरे घर में इफ़्फ़न को अपनी दादी से ही हवशेष से्नह क्ोों था? 

उत्तर - इफ़्फ़न को अपनी दादी से िहुत ज्यादा प्यार था। प्यार तो उसे अपने अबू्ब, अम्मी, 

िडी िहन और छोटी िहन नुज़हत से भी था परनु्त दादी से वह सिसे ज्यादा प्यार हकर्ा 

करता था। अम्मी तो कभी-कभार इफ़्फ़न को डाुँट देती थी और कभी-कभी तो मार भी हदर्ा 

करती थी। िडी िहन भी अम्मी की ही तरह कभी-कभी डाुँटती और मारती थी। अबू्ब भी 

कभी-कभार घर को न्यार्ालर् समझकर अपना िैसला सुनाने लगते थे। नुजहत को जि भी 

मौका हमलता वह उसकी काहपर्ो ों पर तस्वीरें  िनाने लगती थी। िस एक दादी ही थी हजन्होोंने 

कभी भी हकसी िात पर उसका हदल नही ों दुखार्ा था। र्ही कारर् था हक पूरे घर में इफ़्फ़न 

को अपनी दादी से ही हवशेष से्नह था। 

 

  

 

प्रश्न 8 - इफ़्फ़न की दादी के देहाोंत के िाद टोपी को उसका घर खाली-सा क्ोों लगा? 

उत्तर - टोपी और दादी में एक ऐसा सम्बन्ध हो चूका था हजसे शार्द अगर इफ़्फ़न के दादा 

जीहवत होते तो वह भी हिलकुल उसी तरह न समझ पाते जैसे टोपी के घरवाले न समझ पाए 

थे। दोनो ों अलग-अलग अधूरे थे। एक ने दूसरे को पूरा कर हदर्ा था। दोनो ों ही प्यार के प्यासे 

थे और एक ने दूसरे की इस प्यास को िुझा हदर्ा था। दोनो ों अपने-अपने घरो ों में अजनिी और 

भरे घर में अकेले थे क्ोोंहक दोनो ों को ही उनके घर में कोई समझने वाला नही ों था। दोनो ों ने 

एक … 

VIDEO LINK: https://youtu.be/9qqQVsfw4DI  

 

COMPUTER 
             ASSIGNMENT 

             TOPIC -SPREADSHEET 
Answer the following:  

1. List any five conditions/formats/items that can be used for conditional formatting 

2. 2. List seven chart elements. 

Fill in the blanks  

1. ________ of formulas is one of the most powerful features of electronic spreadsheets.  

2. ________ is used for adding the values given in cells automatically without writing the formula. 

 3. AutoSum option is available in ________ group under the Home tab.  

4. AutoSum automatically selects the values around the cells either ________ or ________ 

 5. ________ allows you to change the formatting (font color, border, shading) of the cells based on the values in it.  

6. Conditional formatting is available under ________ group in Home tab.  

https://youtu.be/9qqQVsfw4DI


7. When you freeze a row, ________ remains constant.  

8. Freeze Panes option is available under ________ group in ________ tab.  

9. The panes are formed where your ________ is placed.  

10. To insert a ________, select the row below where you want to insert the page break.  

11. To insert a ________, select the column to the right of where you want to insert the page break. 12. The Breaks 
option is available under________ group in the Page Layout tab.  

13. To return to Normal view after you finish working with the page breaks, you need to click ________ in the ________ 
group under the View tab.  

14. Spreadsheet software provides various page layout options for organizing pages using the ________ View.  

15. Margins option is available under________ group in the ________ tab.  

16. Two types of page orientation are ________ & ________.  

17. Different types of views are available under ________ in the View tab. 

 18. The five types of views available are ________, ________, ________, ________ & _______.  

19. The ________ helps you to view a selected area of a workbook. 

 20. Assigning names to cells in a worksheet help you to ________ specific cells.  

21. The Define Name option is available under ________ group in the ________ tab  

22. A chart is a ________ ________ of data, in which the data is represented by symbols, such as ________ in a bar 
chart, ________ in a line chart, or ________ in a pie chart. 23. The three tabs that  

Video link 

https://youtu.be/ln1kkGSHJlk  
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